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Understanding the Administrator Hierarchy

Types of Administrators

Enterprise Administrator: One contact in the company who has access to the entire organization. 

This person can set up all Groups, Departments, and Users within the Enterprise.

Group Administrator: A person who has administrative rights to a specific Group and can configure and 

manage any Department or User assigned to their Group.

Department Administrators: A person who has administrative rights to a specific Department and can 

configure and manage Users assigned to the Department.

The diagram below summarizes the hierarchy.

The Role of an Administrator
The Administrator is responsible for provisioning services to the Group, Department, or individuals (Users). This 

includes resetting passwords, updating Users’ profiles and changing the parameters of specific services for the 

Group or individual Users, such as Voice Messaging, Auto Attendant, and Custom Call Routing.

Logging in to Your managedIP Web Portal
1. Log in at www.tdsmanagedip.com

2. Enter your User ID and Password (provided by TDS)

User ID: _____________________________________

Password: ___________________________________

3. This will take you to the Announcement page.

Note: View the “Administrator Web Portal Tutorial - Navigation” to learn navigation tips and how 
to maneuver within the portal. You can access this video on the managedIP support site at 
support.tdsmanagedip.com.
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Setting Up Your Enterprise Information

Enterprise Profile
The Enterprise Profile allows you to set up your company information, change your Enterprise Administrator login 

password that was assigned to you, view Call Processing Policies, and pull reports to quickly see what users are in 

each group or department.

To update the Enterprise Profile:

1. Hover over Profile and click “Contact Information”

2. Update your company info

3. Update the Administrator Contact Information

4. Click “Save”

To change your password:

1. Hover over Profile and click “Change Password”

2. Enter the Current Password assigned by TDS

3. Enter your New Password

4. Re-type your New Password

5. Click “Save”

Note: For security purposes you will be required to change your default password during your first 
login. Please see page 25 for passcode rules

Resources and Utilities
Resource and Utilities are both view-only menus. Resources will show the Group and User Services Authorizations 

and Service Pack Consumption. Service Descriptions are in alphabetical order and can be very helpful in  

learning your new system features and functionality. The Utilities Menu provides a view of all users in your  

Enterprise, along with quick links to view detail and create a PDF of Directory information. Answer Confirmation 

allows you to create a custom message that will be heard for features using Answer Confirmation.

Setting Up Your Group-Level Information

Accessing Groups
To access the Group you would like to manage or configure, select the Group name from the dropdown menu.
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Group Profile
Update the Group Profile Section with your company information. Typically, each physical business  

location is a unique Group.

Edit Group Information:

1. Select your Group from the dropdown filter

2. You will automatically be routed to “Profile, Group Profile”

3. Enter a Group Name (if you have multiple Groups, be sure to give each one a unique name)

4. Enter the Group Address information

5. Complete Administrator information (Main contact for the particular Group)

6. Click “Save”

Note: The Administrator’s Contact Name, Phone, and Email Address are for reference only. To add an 
Administrator, see the Administrator section on the next page.

Group Dialing Plan (Location Codes)
If you have multiple locations where the last 3 or 4 digits from one employee could potentially be the same  

as another employee (e.g., location A and B both have an extension of 2200), assign a location code for  

each Group. By assigning a Location Dialing Code—such as 55 for Group A—employees will dial 55 plus  

the extension (e.g., 552200) to reach the correct party. If you have all unique 3- or 4-digit extensions for all  

employees, this feature will not be needed.

To set up a Location Dialing Code:

1. Select the Group requiring a location code

2. Scroll down to Group Dialing Plan

3. Enter a 1 or 2 digit Location Dialing Code

4. Click “Save”

Note: For calls made within a Group (same site location), Users will not dial a location code. Therefore, 
the managedIP–Assistant Toolbar Group Directory will only display the Location Dialing Code for other 
locations in the Enterprise. Users may need to restart the managedIP Assistant–Toolbar application 
before they can view the Location Dialing Codes in the Group Directory.
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Administrators
Depending on your organization, you may have multiple Groups within your Enterprise.  

You can add Group and/or Department Administrators.

To add an Administrator:

1. Select the Group from the dropdown menu

2. Hover over Profile

3. Click on “Administrators”

4. Click “Add” and enter in the information

5. Select Administrator Type (Group or Department) toggle

6. Click “Save”

Note: If you are going to assign Department Administrators, you will need to set up your Departments 
first. All available Departments will appear in the dropdown menu after the Department selection. To 
learn more, go to the Departments section of the User guide.

 

To edit or delete an Administrator:

1. Select the Group from the dropdown menu

2. Hover over Profile

3. Click on “Administrators”

4. Select the Administrator from the dropdown menu

5. Edit the information or click the “Delete” button

6. Click “Save”

Time Schedules and Holiday Hours
Group Time Schedules and Holiday Schedules allow you to set up standard schedules to use when  

configuring features and services, such as Auto Attendants or Custom Call Routing. We recommend setting 

up a Business Hours Schedule. By doing this, services like an Auto Attendant will play an automatic after-hours 

greeting and dialing menu when the business is not open. Time schedules are available for use (but may  

not be modified) by all Users associated with the Group.
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To program the company’s Time Schedules:

1. Select your Group from the dropdown menu 

2. Hover over Profile and click “Time Schedules” 

3. Click the “Add New Schedule” button to define a new schedule

4. Type in a name for the new schedule (e.g., “Business Hours”) and click “OK”

5. �Using the mouse, click and drag over the timetable to define your desired time schedule. Click “Save”  

when complete to save your changes. 

Note: To add an additional Time Schedule, click “Add Time Schedule” and follow the guidelines above.  

You’ll notice that each time schedule defined may be accessed via a tab above the timetable with the  

time schedule’s name(s). 

To define Holiday Hours:

1. Select your Group from the dropdown menu

2. Hover over Profile and click “Holiday Schedule”

3. Click “Add Holiday Schedule”

5. Populate the name for the schedule (e.g., Memorial Day)

6. Modify schedule to reflect your holiday hours

7. Click “Save”

Note: Holidays must be added/modified every year as they are date specific and change annually. 
For example, Thanksgiving moves every year to fall on a Thursday so the date changes.
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Departments
Departments are subsets of Users within a Group for the purpose of assigning Administrators and/or services to a 

subset of Users.

To add a Department:

1. Select the Group from the dropdown menu

2. Hover over Profile and click “Departments”

3. Click “Add”

4. Enter a Name for the Department

5. Select a Parent Department, if applicable (not common)

6. Click “Save”

To edit or delete a Department:

1. Select the Group

2. Hover over Profile and click “Departments”

3. Select the Department from the dropdown menu

4. Edit the information or click the “Delete” button

5. Click “Save”
 
Note: If there are Users, Administrators, or services assigned to a Department, you must un-assign them 
before you can delete the Department.

6



103489/3-11/6943

TDS® managedIP Essentials
Administrator User Guide

Setting Up Your User-Level Information

The next step to setting up your service is to associate an employee’s name to a telephone number. TDS  

will have all the telephone numbers in the system listed by Group. You will want to edit these by adding the  

employee’s last name and first name with the number. This will be helpful for editing the User’s services, if  

necessary, in the future.

Initial setup of Users:
1. Select the Group

2. Select a telephone number from the User dropdown filter

3. In the User Info section, enter the employee’s Last Name and First Name

4. Enter the Calling Line ID, Last Name and First Name displayed for internal calls

5. Assign a Department, if applicable

6. Click “Save”

Note: The remaining information in the User profile will be completed by the User. Continue with all of the tele-
phone numbers in the Group by selecting them on the User dropdown menu. Once completed, move to the 
next Group, if applicable.

Understanding Your Group Services

Group Resources
Resources provide the Administrator with account information on Service Authorizations and Numbers. Service 

Authorizations are a summary of the types of Service Packs assigned to the Group, a description of Group and 

User Services with limits and allocations, and the telephone numbers assigned and ordered for the Group. This 

information is based on the features and services your company has purchased from TDS.
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Configuration of Group Services

Series Completion 
Series Completion permits the routing of calls to an idle line in a prearranged group, when the 

called line is busy. When a call is placed to a busy number the system automatically searchs 

through the ordered list until an idle line is encountered or the end of the list is reached.

To set-up series competion:

1. Hover over Group Services and choose Series Completion

2. In the Series Completion section, click Add

 

3. Enter the name for your group, and click save.

4. Search by Group, Department, Last Name, or First Name to quickly locate users

5. Use the Add or Remove buttons to move users to/from the Assigned Users box

6. Click “Save” 

Auto Attendant 
Auto Attendant is an automated receptionist that answers incoming calls for the Group, based 

on Time Schedules set by the Administrator. It provides your callers with:

• Business and After-Hours Greetings

• Dial-By-Name Directory

• Destination-based Call Routing
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Profile

To modify an Auto Attendant:

1. Select the Group

2. Hover over Group Services and click “Auto Attendant”

3. Select the Auto Attendant you wish to modify from the dropdown filter

4. In the Profile, enter the “Name” of your Auto Attendant

	 • We recommend keeping your naming scheme short (e.g., “Main_AA”)

5. If the service is limited to a Department, assign the Department

6. From the Business Hours dropdown, select Business Hours Schedule

	 • (If “Every Day All Day” is chosen, the Auto Attendant will not present callers with After Hours Greeting 

	    or options. You must have a Business Hours Time Schedule created; see Time Schedules in this guide)

7. Select your Holiday Schedule, if configured

8. Select the Scope of Extension Dialing. This determines whether the Auto Attendant can redirect callers by  

    extension to any User in its Enterprise, Group, or Department.

9. Select the Scope of Name Dialing. This determines whether the Auto Attendant can redirect callers by  

    name to any User in its Enterprise, Group, or Department.

Note: The extension and name dialing scope defaults to Enterprise. If you want to limit a caller’s options to a 
specific Group or Department, select the correct toggle.

10. Select Name Dialing Entries. This determines the format that callers will use for the dial-by-name directory.

11. Click “Save”

Business Hours Tab

The business hours option allows you to customize your Auto Attendant during Business hours. If you leave every-

thing set to default, callers will hear a system greeting telling them their call is being answered by an automated 

attendant and they will then be presented with the standard Interactive Voice Response (IVR) options.
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To configure Business Hours IVR:

1. Select either the Default or Personal Greeting button. (If Personal is selected it requires the recording of the  

    message to be heard by callers.)

	 • Recommended: You can record a custom greeting in your Voice Portal (instructions provided below).

	 • Optional: If you record a greeting (.wav file) using Windows Recorder or another sound recorder, click the 

       Browse button and select the file.

2. Check the “Enable First-Level Extension Dialing” box if you would like to allow the caller to enter the extension  

    of the party they wish to reach without selecting a menu option first

Note: If you enabled first-level extension dialing, you are not able to use the numeric key that is the same as 
the first digit of your extension dialing range. For example, your extensions range from 4500–4599, so you will  
not be able to use 4 in the menu options to the caller.

3. Specify the menu options for callers, as stated in the greeting you record or selected. Once complete, click Save.

Your menu options are:

Key: List of the keys available on a telephone keypad to which you can assign actions shown in the following table. 

Description: An optional description for the menu option. 

Action: A drop box that allows you to select the action to be performed. The following table describes the 

available actions. This is a required field. 

Phone Number: When you have selected an action that transfers a call, a number must be specified. For internal 

calls, enter a 4-digit extension. For outside calls, enter the 10-digit telephone number.

This Chart shows all the possible actions, what the caller will hear, and what happens when a particular  
action is chosen:

Action Prompt played to caller What happens

Transfer to operator 
“Please wait while your call is 
transferred to the operator.”

Call is transferred to the specified number. If the number is 
not valid, the call ends with the message “Your call cannot be 
transferred, please try again later, thank you”.

Transfer with prompt
Please wait while your call is 
transferred.”

Call is transferred to the specified number. If the number is 
not valid, the call ends with the message “Your call cannot be 
transferred, please try again later, thank you”.

Transfer without prompt None
Call is transferred to the specified number. If the number is 
not valid, the call ends with the message “Your call cannot be 
transferred, please try again later, thank you”.

Name dialing None Access to name dialing

Extension dialing None Access to extension dialing

End call “Thank you for calling.” Call is released

Repeat menu None Menu greeting is replayed

--- 
(Indicates no action has been selected.) Not applicable Menu greeting is replayed
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 After Hours - Tab 

After Hours does not require a Time Schedule. The system will automatically route to the After Hours Greetings 

any time outside of your “Business Hours Time Schedule.” In addition, if you established a “Holiday Schedule” the 

After Hours greetings will play during these times. You configure the After Hours IVR selections in the same manner 

as your Business Hours.

To configure After Hours IVR:

1. Select “After Hours” tab

2. Select either the Default Greeting or Personal Greeting (requires the recording of a message to be  

    heard by callers)

3. Check Enable first-level extension dialing, if required

4. Populate the Description, Action, and Phone Number fields for each key option, as appropriate

5. Click “Save”

Sample IVR Menu

To help you think about setting up your Business Hour and After Hour menu options, an example is provided 

below:

–	Press 0 or wait on the line to reach the Operator.

–	Press 1 to dial by extension (no information is needed for callers to have this option).

–	Press 2 to dial by name (no information is needed for callers to have this option).

–	Press 3 to reach the marketing Department (enter “Marketing” in the Description column and the  

	 phone number of the marketing representative or Custom Call Routing number in the Number column).

–	Press 4 to reach the customer service Department (enter “Customer Service” in the Description column  

	 and the phone number of the customer service representative in the Number column).

11
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Recording Personal Greetings for Your Auto Attendant

To Record Greetings via the Phone: 

1, Dial the Group Voice Portal Number 

2. �Enter the 4-digit Voice Portal Extension Number 

Note: This is not the same phone number as the Auto Attendant. 

3. �Enter your Administrator voice portal default password (Default password will be provided by TDS, to reset or change this 

password, hover over Group Services and click Voice Portal scroll down to the Change Administrator Password section)

Voice Portal Number: ____________________________

Password: ______________________________________

Custom Call Routing (aka Hunting)
Custom Call Routing provides a way to route calls to a Group of selected Users via an Auto Attendant or Direct Inward 

Dial number.

Accessing Custom Call Routing Groups:

1. Select Group

2. Hover over Group Services, click on “Custom Call Routing (Hunting)”

3. All Custom Call Routing Groups assigned to your business will be displayed in the dropdown menu

Call Routing Profile Settings:

1. Select the Call Routing Group you wish to modify

2. Enter the Call Routing Group Name

3. Enter the Calling Line ID Last Name and Calling Line ID First Name

Note: The Calling Line ID First and Last Name will be displayed to Users receiving calls from the Custom Call  
Routing Group. We recommend keeping this short (e.g., “CCR_Support”). This will be displayed along with the  
originating party’s caller ID (room permitting).
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4.	Select the Department to assign the Call Routing (if applicable)

5.	The Time Zone is a default

6.	�We recommend not checking the “Allow Call Waiting on Agents” box as it could impact customer hold 

times. If you desire Call Routing Group members to receive multiple calls at once, check this box.

7.	Select the Group Policy determining how calls are routed to agents

Group Policy Definitions:

•	 Circular: Routes calls through agents in the order they appear in the list, starting with the agent that follows 

	 the last agent to receive a call.

•	 Regular: Route calls through agents in the order they appear in the list, starting from the top of the list 

	 each time.

•	 Simultaneous: Route calls to all agents at the same time.

•	 Uniform: Route incoming calls to all agents in order, starting with the agent who has been idle the longest 

	 and ending with the agent who most recently answered a call. 

•	 Weighted Call Distribution: Route so that incoming calls are routed to idle agents based on percentages 

	 you assign. 
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To Assign Percentages for Weighted Call Distribution:

1. Click Edit

2. Assign the percentages for each agent

3. Click “Save”

Note: Percentages must equal 100%.

Call Routing - No Answer Settings:

1.	Check the box marked “The Skip to next agent” option

2.	Determine number of rings at each station
3.	Optional - The “Forward Call After Waiting” option prevents callers from spending a long duration listening  
	 to ring-back tone, especially in large Call Routing Groups. Callers can be forwarded to the company  
	 receptionist or a voice mailbox. If enabled, you will need to specify the time in seconds and the call  

	 forward destination. (Generally, standard ring cycle is 6 seconds.) 

Call Routing - Adding/Removing Users:

1. Search by Group, Department, Last Name, or First Name to quickly locate users

2. Use the Add or Remove buttons to move users to/from the Assigned Users box

3. �Click “Save”  

To take your call routing Groups to the next level and enhance the ability to serve your incoming calls,  

you can assign additional routing and alert features to the Custom Call Routing Group.
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Additional Call Routing Services:

1. Select Group

2. Hover over Group Services, click “Custom Call Routing (Hunting)”

3. Select the Custom Call Routing Group you want to configure

4. Hover over Calling Features, click “All Services”

Here you can assign additional features to your Call Routing Number. Some of these features include  

Call Forward Busy, Call Forward Selective, and Priority Alert.

Call Forward Busy
Route calls when all agents are busy. For example, if everyone is on the phone, you can route callers to another 

individual or even another Call Routing Group.

To set up Call Forward Busy:

1. Toggle “Call Forward Busy” On or Off

2. Assign a “Call forward number”

Call Forward Selective
Assign a time schedule to the Call Routing Group. For example, route calls directly to an Auto Attendant for after-

hour calls or set up time schedules for On Call technical support that automatically forwards calls to someone’s 

cell phone at specific times.

To set up Call Forward Selective:

1. Click “Edit”

2.	For a default call forward number, enter the number

3. Click “Add Rule”

4. Enter in the Description of the rule

5. Select the Time Schedule you want the rule active

15
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Note: You must set up “Time Schedules” prior to configuring this service. See the Time Schedules section 
of this guide.

6. Select the toggle for what number you want to forward calls to:

	 a. Default forward number (assigned in step 2)

	 b. Alternative number (such as an after hours call center) 

7. Establish what incoming number you want to follow this rule:

	 a. All Incoming number

	 b. Specific phone numbers, then enter in the specific telephone numbers desired.

8. Click “Save”
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Account/Authorization Codes

You may select the use of either Account Codes or Authorization Codes for outgoing calls with your managedIP Group. 

•	Account Codes: Non-validated codes that are entered by a User prior to placing a call. The system ensures that 

codes provided by Users contain the required number of digits, but does not validate codes entered. You may 

mandate that a User always enters an Account Code prior to placing a call (“Mandatory Usage”) or you may 

make this optional, requiring the User to dial a Feature Access Code (FAC) prior to placing the call.  

•	Authorization Codes: Validated codes which are required prior to placing a call. Calls are not connected unless a 

valid code is entered. These mandatory codes are defined as a specific length (2 -14 digits) and have a specific 

value, defined by the Administrator.

With the use of both, your business will receive a detailed monthly report, sorting your calls by Account or Authorization 

codes. In addition, if you subscribe to “Enhanced Call Detail Reporting”, your reports will provide the Account Code 

entered by the users. Although this feature may be used for both local and toll calls, your monthly report (mailed to 

your business) will only include the detail for toll calls.  

To configure Account Codes:

1.	Select the Group.

2.	Click Account/Auth Codes in the left navigation bar.

3.	Click Account Code button.

4.	Specify the number of digits (length of codes) the User must dial to make/log call.

5.	Check the box “Allow Local and Toll-Free Calls Without Account/Authorization Code” if you choose to allow  

Users to make these types of calls without a code.

6. 	Search by Department, Last Name, or First Name to quickly locate users.

7. Use the Add or Remove buttons to move users to the appropriate box for mandatory or optional usage. 

	 • �The Mandatory Usage box will require all users assigned to enter an Account Code before their call can 

be placed.

	 • �The Optional Usage box will require users to enter a feature access code prior to making a call to prompt them 

to enter an Account Code.

8. Click “Save.”
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To configure Authorization Codes: 

1. Select the Group. 

2. Click Account/Auth Codes in the left navigation bar. 

3. Select the Authorization Code button

4. Specify the number of digits (length of codes) the User must dial to make/log call.   

  Note: All codes must be the same length. 

5. Check the box “Allow Local and Toll-Free Calls without Account/Authorization Code” if you choose to allow  

Users to make these types of calls without a code. 

6. Search by Department, Last Name, or First Name to quickly locate users.

7. Use the Add or Remove buttons to move users to the ”Restricted Users” area. Click “Save” to save your changes. 

8. In the Codes Management section, enter the code and description for each verified account code users will 

require. Click “Add” to add the code to your list. 

9. Repeat this process to add additional codes 

10. Click “Save.”
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Calling Plans

Policies
Configure and manage calling plans for members in your Group. Plans allow or block specific call types 

from being received or placed by all members in the Group, in addition to control over call.

Codes Management

Set up authorization codes that will be required for outgoing call plan policies.

To add a code:
1. Enter the code and description
2. Click Add
3. Proceed with adding each Authorization Code you need to configure

To delete a code:
1. Check the box by the code you wish to delete
2. Click Delete

Digit Strings
If more granularity is required when allowing or blocking calls, digit strings provide an easy solution. Digit 
strings filter incoming and outgoing calls based on exact digit string patterns, like a 10-digit phone number. 
You provide a name and enter in the digits exactly as they would be dialed or received.

Transfer Numbers
Use the transfer numbers feature located under the calling plan options menu for a particular call type to  
automatically transfer to a specific location when dialed.

To program Transfer Numbers:
1. Enter Transfer Numbers

2. Click “Save”
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Incoming Calling Plan
You can prevent the following types of calls: Calls From Within Group, Calls From Outside Group, Collect Calls,  

and call types represented by customizable digit strings the system matches against outside numbers.

Note: It is recommended that you use the defaults for Incoming Calling Plans.

Outgoing Calling Plan: 

1. Review the Outgoing Call Types
2. In the Originating column, select how you want calls to be handled (see Legend)
3. Click “Save”

Example: If you would like to block employees from dialing International numbers, select N for no in the International 

numbers row from the dropdown menu. Now all International calls will be blocked and Users will hear a recording.

Note: While these settings will affect all Users in the Group, individual User calling plans can be modified at the 
User level. Navigate to that User, click on Calling Features,”All Services,” and scroll to Call Plans. Click “Edit”  
and then click on the “Custom Box.” This will allow you to adjust calling plans for a specific User.
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Utilities

Most of the Utilities menu selections are view-only or set to default to the best recommended solution. Below 

is a brief description of each Utility option available.

Call Detail Reporting

Enables access to call history reports of users based on specific criteria such as date ranges or types of calls. 

To use this service: 
1. Select a user from the User dropdown. 
2. Select Sort Options using the Sort By fields.
3. Enter a start and end date in the Date range fields.
4. �Select the type of calls to be included in the report by checking the appropriate box(es) (e.g., Inbound, 

Missed, or Outbound) 
5. �To search by specific criteria, enter a complete or partial phone number in the text box to and click  

create report. For example, if you enter “756,” all the telephone numbers containing the digits “756” will be 
included in the report. 

6. To email your report, enter an email address and click Submit.
7. To export your report to a PDF or CSV, click the appropriate Submit button.

Note: A maximum of 2,000 records may be displayed on your Web browser, or 5,000 records with a PDF 
or email report. Excel downloads display all records available. However, this may be limited based on the 
version of Excel you are using.

Item Description

Policies View Group Web and Call Processing Policies.

Calling Line ID
Configure the name and/or number of the Group to display on the caller ID for 
outgoing calls instead of the User who placed the call.

Inventory Report Generate and email a report on the resources used within the Group.

Enterprise Directory At a glance Enterprise Directory in the portal.

Custom Contact Directories
Create a custom contact directory with a subset of members from the Group  
or Enterprise.

Common Phone List
Store a frequently called numbers list for the Group so they can easily be dialed 
from the User’s CommPilot Call Manager. You can quickly add to the list by 
importing a phone list from a CSV file.

Disaster Redirect
This allows an admin to update the entire Group’s Call Forward Not Reachable 
setting.

Feature Access Codes
View feature access codes settings from TDS. Alternate codes are optional and  
are configured by the Enterprise Administrator.
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Ongoing Management of Users

Change User Passwords

Users will change and set up their own unique passwords. However, as the Administrator you may need to 

reset them from time to time if a User gets locked out of the system or leaves the company. Please see 

page 25 for Passcode Rules.

To change a User’s password: 

1. Select the User from the dropdown menu

2. At the User Profile screen, click the “Change Password” button

3. Enter a pre-defined password or select the button to auto generate

4. Click “Save” 

User Services 

The Administrator has access to User services and can—via the Web portal—activate, deactivate, and 

customize these services. Some of the services an Administrator might update for a User include configu-

ration of Incoming and Outgoing calls, Call Control, Calling Plans, Messaging, and Client Applications. 

The User service pages are a good resource when helping a User who is experiencing issues with their 

service. An Administrator can quickly route to how their services are configured. The services available to 

Users are dependent on the specific service package purchased for a station.
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To Manage User Services:

1. Select the User from the dropdown menu 

2. Hover over “Calling Features” and Select “All Services”

3. Update any specific User Features 

4. Click “Save” 

Note: As your employees change, it is important that you go into a User’s profile and delete any special  
configurations and reset the passwords for the User. 

Uploading a Greeting

Below is the procedure to record a personal greeting or announcement using a PC. Instructions are provided for 

the following sound recorders:

• Windows 98 Sound Recorder and Windows XP Sound Recorder

• Windows 2000 Sound Recorder

• Windows NT Sound Recorder

If you are using a different sound recording product, the required format for recordings are:

• CCITT u-Law or A-Law

• 8,000 kHz

• 8-bit mono

• .wav file 

To record using the Windows 98 Sound Recorder or Windows XP Sound Recorder:

1.	 In Windows 98, select Start> Programs> Accessories> Multimedia> Sound Recorder from the 

	 Windows task bar. 

	 In Windows XP, select Start> All Programs> Accessories> Entertainment> Sound Recorder.

Note: It is possible that your Sound Recorder is in a different location, or that your default sound recorder is 
another product. Please note the required format for your greetings below and follow the instructions for your 
specific sound recording product.

2.	 Make the setting selections. Click Properties from the File menu. The properties for Sound window appears.

3.	 Click Convert Now and then click OK. The Sound Selection page appears.

4.	 Select CCITT u-Law from the Format list.

5.	 Select 8,000 kHz, 8-bit mono under Attributes and click OK. You may want to save this format at this point, so 	

	 that you can easily select it in the future.
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6.	 In the Properties for Sound dialog box, click OK.

7.	 Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your message. When 	

	 you have finished, click Stop. To listen to your message, click Play. If you are not pleased with your message, 	

	 record it again.

8.	 When you are satisfied with your message, select Save As from the File menu. Name your sound file, being 	

	 certain that you remember its location and that the file type is a .wav file.

9. In the File name field, enter the desired name of your recording.

10. Click OK. To exit without saving, click Cancel.

To record using the Windows 2000 Sound Recorder:

1. Start> Programs> Accessories> Multimedia> Sound Recorder from the Windows task bar.

Note: It is possible that your Sound Recorder is in a different location, or that your default sound recorder is 
another product. Please note the required format for your greetings below and follow the instructions for your 
specific sound recording product.

2.	Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your message. When 

you have finished, click Stop. To listen to your message, click Play. If you are not pleased with your message, 

record it again.

3.	Click OK.

4.	Click Change to modify the settings. Select CCITT u-Law from the Format list. Select 8,000 kHz, 8-bit mono 

under Attributes and click OK. You may want to save this format at this point, so that you can easily select  

it in the future. In the Properties for Sound dialog box, click OK.

5.	When you are satisfied with your message, select Save As from the File menu. Name your sound file  

as .wav file.

6.	In the File name field, enter the desired name of your recording.

7.	Click OK. To exit without saving, click Cancel.

To record using the Windows NT Sound Recorder:

1.	Select Start> Programs> Accessories> Multimedia> Sound Recorder from the Windows task bar.

2.	Select Audio Properties from Edit menu. Click on the Customize button under Preferred quality. The Customize 

dialog box appears.

3. In the dropdown menu under Format, select CCITT u-Law.

4. In dropdown menu under Attributes, select 8.000 kHz, 8-bit mono. You may want to save this format at this 

point, so that you can easily select it in the future.
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5. Click OK in the Customize dialog. Then click OK in the Audio Properties dialog box.

6. Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your message. When 

you have finished, click Stop. To listen to your message, click Play. If you are not pleased with your message, 

record it again.

7. Click OK.

8. When you are satisfied with your message, select Save As from the File menu. Name your sound file as  

.wav file.

9. In the File name field, enter the desired name of your recording.

10. Click OK. To exit without saving, click Cancel. 

Passcode Rules

Voice Messaging
• Cannot be a single repeated digit 

• Cannot be or contain the user’s own extension or phone number 

• Cannot be the reverse of the user’s extension or phone number 

• Cannot be the old passcode 

• Cannot be the reverse of the old passcode

• Cannot be sequential digits in either increasing or decreasing order

• Cannot be repeating sequences (e.g., 123123, 242424, 43214321) 

• Must be at least 5 digits, no more than 8 digits 

• Expires after 365 days

• Disabled after 5 failed login attempts

Web Portal
• Cannot contain your login ID

• Cannot be your old password

• Must contain at least 1 number, 1 uppercase and 2 lowercase alpha characters.

• Cannot be the reverse of an old passcode

• Must be a minimum of 8 characters

• Expires after 180 days

• Disabled after 5 failed login attempts
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